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1 PageGate GUI Client

PageGate GUI Client Next

The  PageGate  GUI (Graphical  User  Interface)  Client  is  the  Windows  based  graphical
client  for the PageGate Paging application.  It  allows workstations on a network  to send
messages  to  the  PageGate  paging  server,  which  in  turn  delivers  the  messages  (via  a
modem, a direct  cable connection,  or the internet) to your paging carrier(s)  for  delivery.
Your  paging  carrier  will  then  send  the  message  to  the  appropriate  pager,  phone,  or
wireless messaging device. The PageGate GUI Client program is one of several front-end
interfaces  available  for  the  PageGate  paging  server.  It  can  be  used  alone,  or  in
conjunction with any or all of the other interfaces.
 
The PageGate server application must  be installed and configured before the  PageGate
GUI  Client  can  be  used.  Please  refer  to  the  PageGate  Server's  help  file  for  more
information on the installation, configuration, and operation of the PageGate Server.
 

1.1 Overview

Overview Top  Previous  Next

The  PageGate  GUI (Graphical  User  Interface)  Client
is  the  visual  interface  for  the  PageGate  Server.  It
allows workstations on a network  to send  messages
to  the  PageGate  Server,  which  in  turn  delivers  the
messages to your paging carrier(s) for  delivery.  Your
paging  carrier  will  then  send  the  message  to  the
appropriate  pager,  phone,  or  wireless  messaging
device.  The  PageGate  GUI Client  program  is  one  of
several front-end interfaces available for the PageGate
paging server. It can be used alone,  or in conjunction
with any or all of the other interfaces.
 
The  PageGate  server  application  must  be  installed
and  configured  before  the  PageGate  GUI Client  can
be used.  Please refer to the  PageGate  Server's  help
file  for  more  information  on  the  installation,
configuration, and operation of the PageGate Server.

 

1.2 Configuring the PageGate Client

Configuring the PageGate
Client

Top  Previous  Next

The very first time you run the PageGate Client, you
will be prompted for some information:
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Setting Function

Server Database
This should be the path to the PageGate Server's Database. This can
be either a local path (if you're running the GUI Client on the same
system as the PageGate Server) or a network path.

Preset Msgs File
If you have configured any preset messages, this should be the path to
the Preset messages. This can either be a local path or a network
path.

Sender's Name

By default, this field is set to %LoginName% - This value will use the
username of whoever is currently logged into Windows as the Sender's
Name messages sent from the GUI Client. This field can also be set to
a static value such as Tech, Sales, Jeremy, Lamar, etc.

Display-group This option cannot be configured on initial setup.

Station Number

The Station Number is a unique identifying number for this GUI Client
and allows the PageGate Admin to track how many messages this
instance of the GUI Client has sent and to whom the messages were
sent. If you are performing multiple GUI Client installations, make sure
that no two installations of the GUI Client have the same Station
Number.

Update Frequency
This field determines how often (in seconds) the GUI Client posts data
to the PageGate Database.

Max Msg Length
This field determines how many characters can be typed in the
Message field of the GUI Client.

Enable Spell Check
By enabling this option, the GUI Client will automatically spellcheck
any messages typed. This option requires MS Word to be installed.

Display Options This field cannot be configured on initial setup.

Use these settings for
current user only

Set this option if each Windows User needs to have their own copy of
the GUI Client configured.

Use these settings
for all local users

Set this option if you want these settings to be saved for all Windows
Users who log in to this workstation.

 

1.3 Using the GUI Client

Using the GUI Client Top  Previous  Next
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The  PageGate  GUI  Client  is  used  for  scheduling  and  sending  messages  to  the
PageGate Server's list of Recipients and Groups.  It  shows a list  of available Recipients
and Groups and is highly customizable.
 
The PageGate Client can be run from the paging server or on any workstation that  has
network access to the PageGate Database.
 
Recipients can be moved to the Selected Recipients column simply by  clicking on their
name.
 
The Message Text field is where you type the message you want to send.
 
As shown above, there are many buttons and options within the program.
 
First are the menus:
 

File

Tools

View

Reports

Help
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1.3.1 File

File Top  Previous  Next

 
The two options under the File menu are Setup and Exit.  Selecting the Exit  option will
close the GUI Client.  Selecting Setup will  allow you to modify  the base settings of the
current installation of the GUI Client.

 
When selecting the Setup option, you will be presented with the following options

menu:
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Setting Function

Server Database
This should be the path to the PageGate Server's Database. This  can
be either a local path (if you're  running  the  GUI Client  on  the  same
system as the PageGate Server) or a network path.

Preset Msgs File
If you have configured any preset  messages,  this  should be the path
to the Preset messages. This can either be a local path or a network
path.

Sender's Name

By default, this field is set to %LoginName% - This  value will  use the
username  of  whoever  is  currently  logged  into  Windows  as  the
Sender's  Name  messages  sent  from  the  GUI Client.  This  field  can
also be set  to a  static  value  such  as  Tech,  Sales,  Jeremy,  Lamar,
etc.

Display-group

If you have configured any Display  Groups for the  PageGate  Server,
you can specify  the Display  Group this  installation of the GUI Client
is  locked  to.  By  selecting  a  Display  Group,  this  installation  of  the
GUI Client  will  only  list  those  recipients  that  are  members  of  the
Display Group.

Station Number

The Station Number is a unique identifying number for this  GUI Client
and allows the PageGate Admin to track  how many  messages  this
instance of the GUI Client has sent and to whom the messages were
sent.  If  you  are  performing  multiple  GUI  Client  installations,  make
sure that no two installations of the GUI Client have the same Station
Number.

Update Frequency
This  field  determines  how often  (in  seconds)  the  GUI  Client  posts
data to the PageGate Database.

Max Msg Length This  field  determines  how  many  characters  can  be  typed  in  the
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Message field of the GUI Client.

Enable Spell Check
By enabling this  option,  the GUI Client  will  automatically  spellcheck
any messages typed. This option requires MS Word to be installed.

Display Options Click on this button to view the Display Options.
Use these settings for

current user only
Set this option if each Windows User needs to have their own copy of
the GUI Client configured.

Use these settings for
all local users

Set this option if you want these settings to be saved for all  Windows
Users who log in to this workstation.

1.3.1.1 Display Options

Display Options Top  Previous  Next

 

Setting Function

Remove Preset Buttons
Enabling this  will  remove the Prog1,  Prog2,  Prog3,  Prog4,  Prog5,  and
More buttons.

Remove Options Button Enabling this will remove the Options button.

Remove Logs
Enabling this  will  remove the ability  of this  GUI Client  to  view any  log
files.

Remove Help Enabling this will remove the Help menu.
Remove Spell Checking Enabling this will remove the Spell Checking function of this GUI Client.

Small Recipient Font
Enabling this  will  display  the recipient  and selected recipient  lists  in a
smaller font.

Failure Warning Popup
When this  is  enabled,  every  time a message fails,  you will  be  notified
by a popup window.

Presets Prompting

For this  setting to function  properly,  you  must  first  configure  a  set  of
preset  messages in the PageFate client.  Next,  set  up one  of  the  first
nine presets with a recipient but no message. 

If  that  has  been  done  and  this  option  is  enabled,  if  you  click  on  the
visible  preset  button,  a  pop-up  will  list  all  of  the  possible  preset
messages for that  recipient.  This  allows a user to click  a  preset  for  a
recipient and choose a commonly used message for them.

Confirm Send
When this  is  enabled,  every  time the Send button  is  clicked,  you  will
be prompted to confirm the delivery of the message.

Clear on Send
When  this  option  is  enabled,  the  Message  and  Selected  Recipient
portions of this GUI Client are cleared after the Send button is clicked.

Display group label (G)

You can choose to have the (G) for Group label appear before or  after
your  groups'  names.  If  the  (G)  appears  before,  the  groups  will
automatically  be  sorted  to  the  top  of  the  Recipient  list.  If  the  (G)
appears  after,  the groups will  be sorted by  the first  letter  in  the  group
name.

Minimize To
You can choose to have the GUI Client minimize to the Task Bar or the
System Tray. If the GUI Client  is  set  to minimize to the Task Bar,  you
will  see  it  to  the  right  of  the  Start  Menu  when  the  program  is
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minimized. When the program is set to minimize to the System Tray, it
will  appear as  an icon of  a  pager  next  to  the  clock  in  the  lower  right
hand corner of the screen.

1.3.2 Tools

Tools Top  Previous  Next

The Tools Menu
of the GUI Client
will display the
following options:

 
Filter
Recipients

Presets

Local
Recipients

Check
Spelling.

 
Note: The Check
Spelling option
will not work if
you don't have
Microsoft Word
installed.

 

1.3.2.1 Filter Recipients

Filter Recipients Top  Previous  Next

By  using  the  Filter  Recipients  option,  you  can  filter
the  list  of  recipients  that  is  shown  in  the  'Recipient
List'. You can filter recipients  by  full  name (the name
that  is  displayed  in  the  'Recipient  List'),  by  short
name (the name used by the Admin  program),  or  by
any of for other user definable fields  (these are setup
within the Admin program).
 
In each field,  enter characters  that  must  match  each
recipient to be included in the list.
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To return to the full list, leave all  the filter fields  blank,
or click on the 'Clear' button next to the recipient list

 

 

Setting Function

Full Name This field requires  the Full Name field of a recipient  in the PageGate Admin
to  match  the  pattern  you  enter  here.  For  example,  to  have  only  those
recipients whose Full Name field begins with Tech show in the recipient  list,
you would enter Tech here.

Short Name This field requires the Recipient field of a recipient in the PageGate Admin to
match the pattern you enter here. For example, to have only those recipients
whose Recipient field begins with oncall show in the recipient  list,  you would
enter oncall here.

Comment1 -
Comment4

When creating a recipient  in the PageGate Admin,  you can  specify  certain
comment  fields.  This  field  requires  the  Comment  Field  in  the  Recipient's
Settings to match whatever you enter here.

Filter Clicking on this button will Filter the Recipient list with your criteria.

Close This will close this option dialog without filtering your Recipient view.

1.3.2.2 Presets

Presets Top  Previous  Next

The Presets tool allows you to customize and create
preset messages that will go to a recipient, group, or
list of recipients and groups. This is useful if you need
'canned' messages and don't want to have to type the
same message over and over and over.
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To modify an existing preset message, highlight the
existing line and click on Edit.
 
to create a new preset message, highlight one of the
blank lines and click on Edit.
 
When you click on Edit, you will receive this prompt:
 

 
Simply type in a Description for the preset message,
select a recipient or group, then type in the preset
message.
 
Click on Apply and the preset message will be saved.
 
Click on Close and the settings will not be saved.
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1.3.2.3 Local Recipients

Local Recipients Top  Previous  Next

NOTE: If you have a local recipient list setup, it will be
the default recipient list displayed each time you
startup the PageGate GUI Client.
 
In  the  PageGate  GUI Client,  you  can  select  several
commonly  used recipients  and put  them  into  a  local
(personal)  recipient  list.  This  can  save  you  from
scrolling through a long network recipient list to select
your  most  commonly  used  recipients.  This  local
recipient list is unique to each PageGate GUI Client.
 

 

 
The left  column shows all  recipients  available  to  this
installation  of  the  GUI  Client.  The  right  box  shows
which  recipients  will  be  displayed  in  your  local
recipient list.
 
All you have to do is click on a recipient's name in the
'Network  Recipient  List'  to  move  them  to  the  'Local
Recipient List'.
 
To  remove  someone  from  the  Local  Recipient  List,
click  on  the  recipient's  name  under  the  Local
Recipient List column.
 
The 'Recipient List File' field can be used to centralize
local  recipient  lists  for  multiple  workstations.  This
option allows an administrator  to  keep  a  list  of  local
recipients  for  this  PageGate  GUI Client  in  a  central
location.  This  enables  the  administrator  to  maintain
local user list  files  in a central  location.  The  file  is  a
simple Ascii  text  file with a single recipient  name  on
each line of the file.
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1.3.3 View

View Top  Previous  Next

The View Menu of
the GUI Client
will display the
following options:
 

Pending

Sent

Bad

Scheduled

History

Local Recipients

Network
Recipients

 

1.3.3.1 Pending

Pending Top  Previous  Next

The Pending option of View will show you all messages this GUI Client has scheduled
that are waiting to be delivered.

 

 

Requested
This column displays the Date and Time at which the pending message was
scheduled.

Sent To This column displays to whom the message was intended.
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Message This column displays the message intended for the recipient.

Refresh
Clicking this button will refresh the list of Pending Messages. If a messages has
been sent, it will be removed from this list. If a new message has been queued, it will
be added to this list.

Delete
By highlighting a Pending message and clicking this button, it will cancel the
pending message.

Copy
By highlighting a Pending message and clicking this button, you will be taken back
to the main GUI Client interface, the message will be inserted into the Message
section and the Selected Recipients will be moved.

Close This button closes the Pending Messages view.

1.3.3.2 Sent

Sent Top  Previous  Next

The Sent option of View will show you all messages this GUI Client has successfully
sent.

 

 

Sent This column displays the Date and Time at which the message was sent.

Sent To This column displays to whom the message was intended.

Message This column displays the message sent to the recipient.

Refresh
Clicking this button will refresh the list of Sent Messages. If a new message has
been sent, it will be added to this list.

Requeue
By highlighting an existing Sent message and clicking this button, that message will
be re-sent to the recipient.

Copy
By highlighting a Sent message and clicking this button, you will be taken back to
the main GUI Client interface, the message will be inserted into the Message section
and the Selected Recipients will be moved.

Close This button closes the Sent Messages view.
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1.3.3.3 Bad

Bad Top  Previous  Next

The Bad option of View will show you all messages this GUI Client has failed to send.
 

 

Requested This column displays the Date and Time at which the message failed..

Sent To This column displays to whom the message was intended.

Message This column displays the message intended for the recipient.

Refresh
Clicking this button will refresh the list of Bad Messages. If a new message has
failed to be delivered, it will be added to this list.

Requeue
By highlighting an existing Bad message and clicking this button, that message will
be re-sent to the recipient.

Copy
By highlighting a Bad message and clicking this button, you will be taken back to
the main GUI Client interface, the message will be inserted into the Message section
and the Selected Recipients will be moved.

Close This button closes the Bad Messages view.

 

1.3.3.4 Scheduled

Scheduled Top  Previous  Next

The Scheduled option of View will show you all messages this GUI Client is
scheduled to send.

 
Scheduled messages are not Pending messages until the date and time for their

delivery arrives.
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Requested This column displays the Date and Time at which the message failed..

Sent To This column displays to whom the message was intended.

Message This column displays the message intended for the recipient.

Refresh
Clicking this button will refresh the list of Bad Messages. If a new message has
failed to be delivered, it will be added to this list.

Requeue
By highlighting an existing Bad message and clicking this button, that message will
be re-sent to the recipient.

Copy
By highlighting a Bad message and clicking this button, you will be taken back to
the main GUI Client interface, the message will be inserted into the Message section
and the Selected Recipients will be moved.

Close This button closes the Bad Messages view.

 

1.3.3.5 History

History Top  Previous  Next

The History option of View will show you all messages this GUI Client has processed.
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Requested This column displays the Date and Time at which the message failed..

Sent To This column displays to whom the message was intended.

Message This column displays the message intended for the recipient.

Refresh
Clicking this button will refresh the list of Bad Messages. If a new message has
failed to be delivered, it will be added to this list.

Requeue
By highlighting an existing Bad message and clicking this button, that message will
be re-sent to the recipient.

Copy
By highlighting a Bad message and clicking this button, you will be taken back to
the main GUI Client interface, the message will be inserted into the Message section
and the Selected Recipients will be moved.

Close This button closes the Bad Messages view.

 

1.3.3.6 Local and Network Recipients

Local and Network
Recipients

Top  Previous  Next

If you have configured a set of Local Recipients, you can change views by selecting either option.
If you want to view your Local Recipient List, click on Local Recipients. After clicking on Local
Recipients, you'll notice that the recipient list says (local) next to it.
 
 
If you want to view the Network Recipient List, click on Network Recipients. After clicking on
Network Recipients, you'll noticed that the Recipient List says (network) next to it.
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1.3.4 Reports

Reports Top  Previous  Next

The Reports Menu of
the GUI Client will
allow you to run
reports displaying a
range of messages
that meet a certain
criteria.
 
The Reports Menu of
the GUI Client will
display the following
options:
 
Sent Messages and
Scheduled
Messages

1.3.4.1 Sent Messages

Sent Messages Top  Previous  Next

 

By mousing over the Sent Messages portion of the
Reports menu, you'll be given the option to run a
report of all sent messages by the recipient they were
sent to or by the Date and Time they were sent.
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By Recipient

By Recipient Top  Previous  Next

 

Setting Function

Recipient(s)
You can select  a single  recipient  or  group  or  leave  the  (ALL)
option highlighted to run a report on all recipients and groups.

Start Date The beginning date of the date range the report should show.

End Date The ending date of the date range the report should show.

Start Time The beginning time of the time range the report should show.

End Time The beginning time of the time range the report should show.

Summary, Details, Totals
Only

Summary will give a brief overview of the information requested
whereas  Details  will  include  all  possible  information.  Totals
Only will only output the number of messages reported on,  not
giving any information about the messages themselves.

All Msgs, Good Msgs, Bad
Msgs

The report show you all  messages,  only  those messages that
were sent  successfully,  or only  those messages that  failed to
send.

Print Report This option allows you to print the report to a selected printer.

Preview

When  this  option  is  enabled,  before  the  report  is  actually
printed,  you  are  shown  the  details  of  the  report  and  can
choose  to  either  close  the  preview,  in  which  case  nothing  is
printed, or print the report.

Zero Values
Enabling this  option will  include results  that  have a value of 0.
This option is disabled by default.

Write report to file
When this  option  is  enabled,  the  report  is  written  to  a  file  of
your specification and name instead of queued to the printer.

By Date/Time

By Date/Time Top  Previous  Next

 

Setting Function
Start Date The beginning date of the date range the report should show.
End Date The ending date of the date range the report should show.
Start Time The beginning time of the time range the report should show.
End Time The beginning time of the time range the report should show.

Summary, Details, Totals
Only

Summary will  give a brief overview of the information requested
whereas  Details  will  include  all  possible  information.  Totals
Only will only  output  the number of messages reported on,  not
giving any information about the messages themselves.

All Msgs, Good Msgs, Bad
Msgs

The report  show you all  messages,  only  those  messages  that
were sent  successfully,  or only  those  messages  that  failed  to
send.

Print Report This option allows you to print the report to a selected printer.

Preview
When  this  option  is  enabled,  before  the  report  is  actually
printed, you are shown the details of the report  and can choose
to either close the preview, in which case nothing is  printed,  or
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print the report.

Write report to file
When  this  option  is  enabled,  the  report  is  written  to  a  file  of
your specification and name instead of queued to the printer.

1.3.4.2 Scheduled Messages

Scheduled Messages Top  Previous  Next

 
By mousing over the Scheduled Messages portion of
the Reports menu, you'll be given the option to run a
report of the delivery schedule by the recipient they
were sent to or by the Date and Time they were sent.
 
 

1.3.5 Scheduling Messages

Scheduling Messages Top  Previous 

One of the functions of the PageGate Client  is  to set
up a delivery  schedule for messages.  To  do  so,  you
would  first  select  a  recipient  (or  group)  and  type  in
your message.  BEFORE you click  the  Send  button,
click on the Options button.
 
By  clicking  on  the  Options  button  in  the  PageGate
GUI  Client's  main  screen,  you  will  be  given  the
following prompt:
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With  this  prompt,  you  can  schedule  messages  to
automatically be sent at some point in the future. You
can also determine if that message will repeat or not.
 
To schedule a page  to  be  sent  at  a  future  date  and
time, fill in the 'Send Message When' fields.
 
To  have  the  scheduled  message  repeat,  fill  in  the
"Resend Messages Every" fields to set  the interval at
which the message is resent.
 
Finally, fill in the 'Stop Sending Message' fields  to set
the date and time for the message to stop being sent.
 
For example,  let's  say that  you had a message that,
starting tomorrow, needed to be sent  out  once a day
for the next month.
 
You  would  set  the  "Send  Message  When"  date  to
tomorrow's  date,  set  the  time  for  whatever  time  the
message needs to be delivered.
 
You would then set the "Resend message every"  to 1
day OR 24 hours OR 1440 minutes.
 
The  final  step  would  be  to  set  the  "Stop  Sending
Message" date and  time  to  exactly  one  month  from
the "Send Message When" Date.
 
Click  on  Apply,  then  click  on  the  Send  button.  The
message is now scheduled!
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